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These operating instructions describe the groundwater datalogger

OTT ecolog 800
OTT ecolog 800 3G

The following naming conventions are used to distinguish between the different
device variants within the description:

OTT ecolog 800 (3G) — applies to both device variants
OTT ecolog 800 — applies to OTT ecolog 800 only
OTT ecolog 800 3G~ — applies to OTT ecolog 800 3G only

These operating instructions (version "05-1017") cover the OTT ecolog 800 (3G)
software versions

OTT ecolog 800 firmware: ~ V 2.00.1 and later
OTT ecolog 800 3G firmware: V 1.00.0 and later
OTT Water Logger Operating Program: V 1.70.0 and later

The OTT ecolog 800 (3G) firmware can be found in the "Advanced operation”
mode, "OTT ecolog 800 (3G)" window of the operating program. The version of
the operating program can be found via the "Info" function in the "Help" menu.

We reserve the right to make technical changes and improvements without notice.
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1 Scope of supply

OTT ecolog 800

OTT ecolog 800 3G

2 Order numbers

OTT ecolog 800

OTT ecolog 800 3G

Accessories !

- 1 groundwater datalogger consisting of a communication unit with built-in
GSM/GPRS cellular modem, pressure probe cable with pressure compen-
sation capillary and Kevlar core for longitudinal stabilization, 2 desiccant
capsules; pressure probe with integrated conductivity sensor and datalogger

- 1 lithium battery, DD type (26 Ah); or 1 lithium battery, D type (13 Ah)

- 1 operating instructions
- 1 factory acceptance test (FAT) certificate

- 1 groundwater datalogger consisting of a communication unit with built-in
GSM/GPRS/UMTS/HSPA+ cellular modem, pressure probe cable with pressure
compensation capillary and Kevlar core for longitudinal stabilization, 2 desiccant
capsules; pressure probe with integrated conductivity sensor and datalogger

- 1 lithium battery, DD type (26 Ah); or 1 lithium battery, D type (13 Ah)

- 1 operating instructions
— 1 factory acceptance test (FAT) certificate

Groundwater datalogger
—incl. lithium battery, DD type (26 Ah)
incl. lithium battery, D type (13 Ah)

Groundwater datalogger
—incl. lithium battery, DD type (26 Ah)
incl. lithium battery, D type (13 Ah)

Required ordering information

- Measuring range: 0 ...4/10/20/40/100 m
— System length: 2...200 m (1 % £5 cm)

Adapter plates

for OTT top caps with cut-out

- 3"

— A"

~4,5"

- 5"

- 6"

Universal suspension bracket

for top caps from 3" upwards, without cut-out
as well as for universal installation

"OTT Water Logger Software CD-ROM"
OTT Water Logger Operating Program for PC, and
OTT ecolog 800 (3G) operating instructions (PDF file)

External radio antenna
cable length: 0.5 m
cable length: 1.0 m
cable length: 1.5 m

5-sided key
for locking OTT top caps

Optical reading head OTT IrDA link USB

Calibration container

1) Additional accessories — e.g. plastic top caps, top caps with external or internal radio antenna on request.

55.447.001.9.0
55.447.002.9.0

55.449.001.9.0
55.449.002.9.0

55.446.022.9.2
55.446.023.9.2
55.446.024.9.2
55.446.225.9.2
55.446.026.9.2

55.446.021.9.2

56.572.002.9.7

97.980.131.9.5
97.980.132.9.5
97.980.133.9.5

20.250.095.4.1

55.520.026.9.2
55.445.025.9.2



Spare parts/
Consumables

Lithium battery, DD type (26 Ah)

Lithium battery, D type (13 Ah)

Desiccant capsules
2x in one aluminum bag

Conductivity calibration solution
- 0,1 mS/cm; 1000 ml
- 0,5mS/cm; 946 ml
- 1,412 mS/cm; 1000 ml
-12,856 mS/cm; 946 ml
- 47,6 mS/cm; 1000 ml

97.800.011.9.5

97.800.009.9.5
97.100.296.9.5

55.495.350.9.5
55.495.351.9.5
55.495.352.9.5
55.495.353.9.5
55.495.354.9.5



3 Basic safety information

Read these operating instructions before using the OTT ecolog 800 (3G) for
the first time! Become completely familiar with the installation and operation of
the OTT ecolog 800 (3G) and its accessories! Keep these operating instructions
for later reference.

The OTT ecolog 800 (3G) is designed to measure groundwater levels, the
water temperature and the specific conductivity of the groundwater and to
transmit these measured values through a GSM cellular network. Only use the
OTT ecolog 800 (3G) as described in these operating instructions!

For further information — refer to Chapter 4, "Introduction".

Please note all safety and warning information given within the individual work

steps. All safety and warning information given in these operating instructions

are marked by the following adjacent warning signals:

- Black warning triangle — warning of potential damage fo the unit,
reduced functionality and particularly noteworthy points.

- Black warning triangle with yellow background — there is a
health hazard! Detailed information on the hazard including information on
how fo prevent the hazard and possible consequences of non-observance.

Ensure the electrical, mechanical, and climatic specifications listed in the technical data
are adhered to. For further information — refer to Chapter 23, "Technical data".

When operating the OTT ecolog 800 (3G), keep a minimum distance of
0.2 metres between radio antennae and

- people, as well as

- other electrical equipment/antennae

Handle the pressure probe cable with care. Do not kink the cable or pull it
across sharp edges!

Do not make any changes or retrofits to the OTT ecolog 800 (3G)! If changes
or retrofits are made, all guarantee claims are voided.

Have a faulty OTT ecolog 800 (3G) inspected and repaired by our repair
center. On no account carry out repairs yourself!
For further information — refer to Chapter 21, "Repair".

After putting the unit out of service, properly dispose of the OTT ecolog 800 (3G).
On no account put the OTT ecolog 800 (3G) into the normal domestic waste. For
further information —» refer to Chapter 22, "Note about the disposal of used units".

CAUTION
Risk of burns! Hot device surface at higher ambient temperatures!

The metal parts of OTT ecolog 800 (3G) device surface can get very hot at
higher ambient temperatures). This may lead to burns.

Use protection gloves during installation and maintenance at higher
ambient temperatures!!!

1) > approx. 60 °C / 140 °F

Federal Communications Commission (FCC) Approval

Note: This equipment has been tested and found to comply with the limits for a Class
A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Oper-
ation of this equipment in a residential area is likely to cause harmful interference in
which case the user will berequired to correct the interference at his own expense.

Industry Canada Approval

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme & la norme NMB-003 du
Canada.



4 Introduction

The OTT ecolog 800 (3G) groundwater datalogger is designed to precisely mea-
sure and store groundwater levels and temperatures, as well as the specific electri-
cal conductivity of the groundwater and to transmit these measured values through
a GSM cellular network. The OTT ecolog 800 (3G) also calculates the salinity and
a TDS value (Total Dissolved Solids) based on the specific conductivity.

The pressure probe equipped with a relative pressure probe cell uses the hydrostatic
pressure of the water column to determine the water level. As a reference, a pres-
sure compensation capillary in the pressure probe cable provides the measuring
cell with the current ambient air pressure. Erroneous measurement results due fo
atmospheric air pressure fluctuations are thus eliminated. The OTT ecolog 800 (3G)
measures the specific electrical conductivity using a 4-electrode conductivity sensor
with integrated temperature sensor. The measurement electrodes are made of
graphite.

The temperature compensation process for the conductivity measurement and the
reference temperature used can be chosen as well as the calculation method for
the salinity.

The OTT ecolog 800 (3G) is available in five measuring ranges:
4 m water column (O ... 0.4 bar)

. 10 m water column (O ... 1 bar)

. 20 m water column (0 ... 2 bar)

O O O O

. 40 m water column (O ... 4 bar)
0 ... 100 m water column (O ... 10 bar)

Based on a reference value that is input during startup, the OTT ecolog 800 (3G)
default setting provides measurement results in the form of depth values. Alterna-
tively, levels or pressure values are possible. The measurement intervals (sample
intervals) can be preselected as necessary.

The operating parameters are set using the "OTT Water Logger Operating Pro-
gram" PC software. This software allows the system to be conveniently and flexibly
tailored to a wide range of measurement requirements of a station. The software
can be set to provide a basic or an advanced user interface. The basic user inter-
face allows all settings to be adjusted within a single program window. In the
advanced user inferface, the sample interval can be controlled e.g. by means of
limit events. The software also supports the execution of pumping tests.

The stored measured values are made available through an infrared interface
(IrDA) for wireless readout using PC on which the OTT Water Logger Operating

Program is executed.

The OTT ecolog 800 (3G) includes a built-in cellular modem (with SMA antenna
connector) that is used for remote data transfer and remote parameterizing via
the cellular network. The remote data transfer can be optionally carried out by
SMS text messages or transmission services GSM, GPRS, UMTS 2 or HSPA+ 2.

If necessary — e.g. when the signal strength of the cellular network is low at the
installation site — the factory installed radio antenna may be replaced by an exter-
nal one.

The OTT ecolog 800 (3G) is installed by simply hanging it into observation wells
of 2" in diameter and above. For this purpose, various adapters/suspension
brackets are available as accessories. For power supply, two options are avail-
able: lithium battery, DD type, 26 Ah capacity; lithium battery, D type, 13 Ah
capacity. When using the DD type lithium battery, battery lifetime is (depending
on additional parameters) at least 10 years, taking into account one single remote
data transfer per day. The communication unit of the OTT ecolog 800 (3G) can
withstand temporary flooding (for details, refer to Chapter 23, "Technical data").

1 only OTT ecolog 800
2 only OTT ecolog 800 3G



Fig. 1: Setup of a groundwater
measurement station using the

OTT ecolog 800 (3G).

The OTT ecolog 800 (3G) essentially con-
sists of three components: communication
unit, pressure probe cable, and pressure
probe with datalogger.

OTT ecolog 800 (3G) system length =
length of communication unit + cable
|engih + |eng'r|1 of pressure probe with
datalogger. (The system length is required
when ordering an OTT ecolog 800 (3G).
When setting the OTT ecolog 800 (3G)
operating parameters, the system

length is not required.)
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5 Installing, checking, and replacing batteries

WARNING
Improper handling of batteries involves fire or explosion hazard!

Only use the battery types specified (no rechargeable types).

Always use brand-new batteries. Do not mix used and new batteries.

Do not mix batteries from different manufacturers

Do not charge the batteries!

Avoid short circuits!

Avoid mechanical damage!

Do not open batteries!

Do not expose batteries to fire or to temperatures above 100 °C!

Do not solder on the batteries!

Properly dispose of exhausted batteries. Do not put them into domestic waste.

Suitable battery types
Lithium battery, DD type (26 Ah), (use OTT accessories only); or
Lithium battery, D type (13 Ah), (use OTT accessories only)

Battery lifetimes
The values mentioned below apply to the following conditions: sample interval -
1 hour; one single remote data transfer per doy; system |ength - 50 m.

Lithium battery, DD type : at least 10 years,

Lithium battery, D type : ot least 5 years

Notes

The OTT ecolog 800 (3G) starts measuring after inserting the batteries (there is
no ON/OFF switch).

If the OTT ecolog 800 (3G) is to be shut off — remove the batteries. This will
prevent the batteries from draining prematurely and will stop any recording of
unusable measurements.

When transporting the OTT ecolog 800 (3G) — remove the batteries. This will
prevent the batteries from draining prematurely and will stop any recording of
unusable measurements.

When bringing the unit back into operation, it takes — dependent on how much
data is stored — up to 7 minutes until the OTT ecolog 800 (3G) starts measur-
ing again.



Check the battery voltage as follows

Establish the PC/OTT ecolog 800 (3G) communication link,

refer to Chapters 9.2 or 9.3.

Select the "OTT ecolog 800 (3G)" menu, "View Instantaneous values" function)
— The OTT ecolog 800 (3G) starts an instantaneous value measurement — The
"Observer" window indicates the current battery voltage and the energy drawn
from the batteries so far in Ah.

Criterion for replacing the batteries: Ah drawn

Lithium battery, DD type: > approx. 20 Ah

Lithium battery, D type : > approx. 10 Ah

— Replace the batteries.

(For technical reasons, the battery voltage displayed cannot not be used as a
criterion for replacing lithium batteries.)

Click on the "Exit" button.

Close the operating program.

1) With suitable settings (Menu "File", function "Options"), the operating program starts with the
"Observer" window.



5.1 Power supply using lithium batteries

How to insert the lithium battery

Remove the screw fitting from the communication unit.
Slide the cap and pipe casing of the communication unit approx. 50 cm
towards the pressure probe cable.

Fig. 2: Setup of the OTT ecolog 800 (3G)

communication unit.

Infrared interface

Radio antenna

SIM card slot

Battery compartment

Desiccant unit of

communication unit Lo .
Communication unit

—+— Pipe casing

Cap of the

communication unit

Rubber stop

Pressure probe cable
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Fig. 3: Inserting the lithium battery.

Connect the lithium battery plug to the socket of the electronic unit, as shown in
figure 3.

Lithium battery, D typ

C( (@

Lithium battery, DD type

[

=

Velcro strip Battery compartment Electronic unit

Open the Velcro strip of the battery compartment.

Insert the lithium battery into the battery compartment (D type lithium battery:
insert the battery info the right-hand side (top) of the battery compartment; the
wiring of the D type lithium battery below the heat-shrinkable tubing must be
located at the side or bottom.)

Firmly close the Velcro strip around the lithium battery.

Slide the cap and the pipe casing of the communication unit back up to the
stop. Please note: Do not bend or pinch the battery lead.

Reinstall the screw fitting to the communication unit.

13
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How to replace the lithium battery

Open the top cap/observation well cover.

Pull and hold the communication unit approximately 1 m out of the observation
well (a second person would be useful).

Remove the screw fitting from the communication unit.

Slide the cap and pipe casing of the communication unit approx. 50 cm
towards the pressure probe cable. (The rubber stop located on the pressure
probe cable (refer to Fig. 2) prevents the pipe casing from falling. Do not move
the rubber stop!)

Disconnect the lithium battery plug from the socket of the electronic unit, while
pressing the connector latch.

Open the Velcro strip of the battery compartment.

Remove the exhausted lithium battery and make sure not to pull the lead!
Within 10 minutes, connect the lithium battery plug to the socket of the elec-
tronic unit, as shown in figure 3.

Insert the lithium battery into the battery compartment (D type lithium battery:
insert the battery info the right-hand side (top) of the battery compartment; the
wiring of the D type lithium battery below the heat-shrinkable tubing must be
located at the side or bottom.)

Firmly close the Velcro strip around the lithium battery.

Slide the cap and the pipe casing of the communication unit back up to the
stop. Please note: Do not bend or pinch the lithium battery lead.

Reinstall the screw fitting to the communication unit.

Slowly and carefully reinsert the communication unit info the observation well.
Delete the power consumption value (power drawn from battery in ampere
hours) in the "Observer" window of the operating program. For more infor-
mation, please refer to online help in the operating program.

Close the top cap/observation well cover.

Notes

The OTT ecolog 800 (3G) stores the measured values in a non-volatile memory.
There is no loss of data when changing batteries.

This also applies to storage without batteries for a long period.

If replacing the batteries takes longer than approx. 10 minutes the time (and
possibly the date) will have to be re-entered, refer to Chapter 15, "Setting date
and time". Furthermore, it takes — dependent on how much data is stored — up
to 7 minutes until the OTT ecolog 800 (3G) starts measuring again (during this
time, the OTT ecolog 800 (3G) re-initializes its database).

When replacing the batteries, we recommend changing the desiccant capsules
at the same time, refer to Chapter 18.2, "Replacing the desiccant capsules".

5.2 Note on power supply using alkaline batteries

OTT ecolLog 800: power supply with alkaline batteries is no longer possible for
devices with a serial number = 420208 (production date later than 21.06.2017!

Due to various technical modifications the optional battery holder* for alkaline
batteries is not suitable for the new OTT ecolog 800.

* until July 2017 the battery holder for alcaline batteries was available as accessory

OTT ecolog 800 3G: power supply with alkaline batteries is not possible for
this device version!



Fig. 5: Inserting the SIM card.

6 Inserting a SIM card

For communicating over the cellular network, a SIM card is required.

(Type Micro-SIM card)

How to insert the SIM card:

Remove the screw fitting from the communication unit.

Slide the cap and pipe casing of the communication unit approx. 50 cm
towards the pressure probe cable, refer to Fig. 2.

Temporarily disconnect battery (refer to Section 5.1).

Make sure not to touch the gold-colored contacts of the SIM card!

Insert the SIM card into the silver-coloured SIM card slot as shown in Fig. 4:
(with the bevelled edge pointing left) until you hear it clicking into place.
Make sure that the SIM card is fully inserted and engaged!

SIM card slot

Reconnect battery (refer to Section 5.1).

Slide the cap and the pipe casing of the communication unit back up to the
stop. Please note: Do not bend or pinch the battery lead.

Reinstall the screw fitting to the communication unit.

Changing/removing the SIM card

Press the SIM card approx. 1 mm further into the SIM card slot before letting
go. The SIM card will then be ejected a few millimeters and can easily be
pulled out.

15
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Fig. 5: Connecting an external
radio antenna.

7 If required: Connecting an external radio antenna

If the local signal strength of the cellular network prevents transmitting from the
closed observation well, an external radio antenna (accessory) is to be connected
to the OTT ecolog 800 (3G). In this case, only the dedicated external radio
antenna specified by OTT must be used for this particular application (cable
length max. 3 m).

You may fasten the external radio antenna to a suitable location using the shim
and nut supplied (drilling a hole for the thread of the external antenna is required:
@ approx. 18 mm). For this installation, an individual solution to fasten the exter-
nal antenna must be found depending on the station.

If the observation well is closed by a top cap you need to have a hole in the
observation well so that the antenna cable can be routed to the outside (to prevent
rain water from entering info the observation well, it is recommended to place the
hole on the side). If required seal the cable feedthrough.

How to connect an external radio antenna

Depending on the particular local situation (diameter of the observation well, type
of the top cap, and other mounting characteristics), the external radio antenna

must be connected prior to or during installation. Please note the relevant chapters
8.2 through 8.4.

Carefully unscrew the factory mounted antenna by hand.

Route the plug of the antenna cable through a hole in the observation well.
Connect the plug to the antenna socket and hand-tighten the locknut.

Fasten the external radio antenna to a suitable location outside the observation
well.

Radio antenna

o ‘ Plug of external radio antenna
Communication \
unit Antenna socket

Notes

When installing an external radio antenna, the minimum distance to people
and other electrical equipment or antennae must be at least 20 cm.
Additional accessories for optimizing the radio conditions at the station are
available on request (e.g. plastic top caps, top caps with external or internal
radio antenna).



8 Installing the OTT ecolog 800 (3G) unit

The OTT ecolog 800 (3G) is installed by hanging it into the observation well.
The necessary accessories and type of installation vary depending on the diameter
of the observation well and the design of the top cap:

2" observation wells refer to 8.1
OTT top cap with cut-out for adapter plate
4" or 6" observation wells, refer to 8.2
OTT top cap with cut-out for adapter plate
Observation wells of 3" in diameter and above, refer to 8.3
Top caps without cut-out for adapter plate
Special case: observation wells beginning at 3" in diameter refer to 8.4

without top cap, universal installation

Fig. 6: Accessories for installation — Part 1

1 = drilled hole for OTT ecolog 800 (3G) 6" adapter plate
2 = cut-out for screws of the top cap
3 = cut-out for contact gauge

Adapter plates for observation wells having
other dimensions are available on request,
refer to the "Order numbers" chapter.

(Each adapter plate consists of two
parts and three bolts. In the figure, the
adapter plates are shown in installed 2
condition (on delivery, they are not
installed). Furthermore, an O-ring is
supplied with the adapter plates.

4" adapter plate

3" adapter plate

17



Fig. 7: Accessories for installation — Part 2

1 = drilled hole for OTT ecolog 800 (3G)

Fig. 8: Installing the OTT ecolog 800 (3G)

18

into a 2" observation well.

Universal suspension bracket ]

8.1 Installing the unit into 2" observation wells,

top cap with cut-out

Required accessories: 2" OTT top cap with cut-out

How to install the OTT ecolLog 800 (3G)

Preliminary work: If not already done, install batteries and SIM card,

refer to Chapter 5.

Open the top cap.

Determine the current depth using a contact gauge and note the measured
value.

Insert the pressure probe into the observation well.

Slowly and carefully lower the pressure probe by means of the pressure
probe cable!

Insert the communication unit into the observation well until the upper part of
the communication unit is fully seated on the top cap, refer to Fig. 8.

Set the operating parameters, refer to Chapter 9.

Close the top cap.

——— OIT top cap

Communication unit

Infrared interface

——— 2" observation well




Fig. 9: Install the adapter plate to the upper
part of the communication unit.

Example: 4" observation well.

8.2 Installing the unit into 3", 4" or 6" observation wells,

top cap with cut-out for adapter plate

Required accessories: OTT top cap with appropriately sized cut-out and
compatible adapter plate (incl. O-Ring).

How to install the OTT ecolog 800 (3G)

Preliminary work: If not already done, install batteries and SIM card,

refer to Chapter 5.

Put the O-ring over the upper part of the communication unit and slide 20 mm
down.

Slide the lower part of the adapter plate (horseshoe-shaped) below the commu-
nication unit over the pressure probe cable and, on the communication unit,
slide it up horizontally until it touches the O-ring.

Slightly tilt the lower part of the adapter plate and, while rotating it, slide it up
over the O-ring.

Slide the O-ring and the lower part of the adapter plate up until the O-ring is
seated in one of the grooves provided for it.

Assemble the required upper part of the adapter plate (3", 4", or 6") as shown
in Figure 9 with the lower part using three M 2.5 socket head bolts.

Open the top cap.

3" observation wells: Determine the current depth using a contact gauge and
note the measured value.

Insert the pressure probe into the observation well.

Slowly and carefully lower the pressure probe into the observation well
with the pressure probe cable, refer to Fig. 10!

Insert the communication unit with adapter plate assembled into the observa-
tion well until the adapter plate and the upper part of the communication unit
are fully seated on the top cap. Align as shown in Figure 11.

4" and 6" observation wells: Use a contact gauge to determine the current depth
and record it (in the adapter plate, there is a cut-out for the contact gauge).

Set the operating parameters, refer to Chapter 9.

Close the top cap.

g\ Socket head bolt (x3)

7

\ Adapter plate

J

upper part
(example: 4")
Adapter plate Communication unit
lower part upper part
\ﬂr O-Ring
~—— Communication unit
Note

As an dlternative to the procedure described above, you may install the
adapter plate independently of the communication unit. In this case, you have
to feed the pressure probe through the O-ring and the hole in the adapter plate
and to pull the entire pressure probe cable.

19



Fig. 10: Feed the communication unit and

Fig.

20

adapter plate into the observation well.

11: Installing the OTT ecolog 800 (3G)
into a 3", 4" or 6" observation well.

Example: 4" observation well.

Adapter plate

Top cap

,,é‘\—\ij\‘//Communicoﬁon unit
@ upper part

Cut-out for
OITT ecolog 800 (3C)

Pressure probe cable

| Pressure probe

4" adapter plate

/ N OflTtop cap

Cut-out for
} contact gauge




8.3 Installing the unit into observation wells of 3" in diameter
and above, top cap without cut-out for adapter plate

For this installation case, an individual solution fo fasten the OTT ecolog 800 (3G)
must be found depending on the station. Example: fix the universal suspension
bracket using an M6 hex head bolt/hex nut laterally to the upper end of the
observation well.

Required accessories: universal suspension bracket, mounting bolts, e.g.: M6
hex head bolt, washer, and Mé hex nut (all made of stainless steel).

How to install the OTT ecolLog 800 (3G)

Preliminary work: If not already done, install batteries and SIM card,

refer to Chapter 5.

Open the top cap.

Drill 2 holes (& 6.5 mm, 20 mm apart) laterally into the upper end of the
observation well.

Please note: The universal suspension bracket is to be mounted in such a
way that there is a gap of a few millimeters between the top cap and the
infrared inferface with the top cap closed. Otherwise there will be a risk of
damaging the infrared interface when the top cap is closed, refer to Fig. 13.
Attach the universal suspension bracket to the observation well using two Mé
hex head bolts, washers, and Mé hex nuts. Use the two lower of the three
drilled holes of the universal suspension bracket, refer to Fig. 12.

Pass the pressure probe through the cut-out of the universal suspension bracket.
Slowly and carefully lower the pressure probe into the observation well
with the pressure probe cable.

Pass the communication unit through the holes of the universal suspension
bracket until the communication unit is seated on the universal suspension
bracket, refer to Fig. 13.

Defermine the current depth using a contact gauge and note the measured
value.

Set the operating parameters, refer to Chapter 9.

Close the top cap.

Note

If protection against vandalism is required Mé threads are to be tapped into
the observation well instead of mounting the unit by means of hex nuts.
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Fig. 12: Mounting diagram for universal
suspension brackets in observation wells
of 3" and above.

Example: 4" observation well

Minimum clearance (A) of the upper hole
to the upper edge of the opened top cap:
43 mm!

Fig. 13: Installing the OTT ecolog 800 (3G)
into observation wells of 3" diameter and
above with a top cap without cut-out.

Example: 4" observation well.
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Fig. 14: Mounting diagram for universal
suspension brackets in observation wells
of 3" and above.

Example: 4" observation well

If required, you may fix the universal sus-
pension bracket reversed by 180° as well.
The socket head bolts will then be easily
accessible. In small diameter observation
wells, you may not be able to place the
optical reading head on the infrared inter-
face when establishing a communication
link. In such a case, position the reading
head in a maximum distance of 25 cm
above the infrared interface.

8.4 Installing the unit into observation wells of 3" in diameter
and above, without top cap, universal installation

For this installation case, an individual solution fo fasten the OTT ecolog 800 (3G)
must be found depending on the station. Example: fix the universal suspension
bracket using an M6 hex head bolt/hex nut laterally to the upper end of the
observation well.

Required accessories: universal suspension bracket, mounting bolts, e.g.: M6
hex head bolts, washers, and Mé hex nuts (all made of stainless steel).

How to install the OTT ecoLog 800 (3G) (example)

Preliminary work: If not already done, install batteries and SIM card, refer to
Chapter 5.

Drill 2 holes (& 6.5 mm, 40 mm apart) laterally into the upper end of the
observation well, refer to Fig. 14.

Attach the universal suspension bracket to the observation well using two Mé
hex head bolts, washers, and M6 hex nuts. Use the uppermost and lowermost
of the three drilled holes of the universal suspension bracket, refer to Fig. 14.
Pass the pressure probe through the cut-out of the universal suspension bracket.
Slowly and carefully lower the pressure probe into the observation well
with the pressure probe cable.

Pass the communication unit through the holes of the universal suspension
bracket until the communication unit is seated on the universal suspension
bracket, refer to Fig. 13.

Determine the current depth using a contact gauge and note the measured
value.

Set the operating parameters, refer to Chapter 9.

Universal suspension

—  bracket

2x drilled hole, @ 6.5 mm

40 mm clearance

) ~ \Hexcgon
@G. S bl
Hex nuts L \ % /
N Washers / @
7) /
AN

Observation
well

Note

If protection against vandalism is required Mé threads are to be tapped into
the observation well instead of mounting the unit by means of hex nuts.
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9 Setting OTT ecolog 800 (3G) operating parameters

To set the OTT ecolog 800 (3G) operating parameters, you will need the "OTT
Water Logger Operating Program" PC software (WBSPLO.exe). This software is
found on the "OTT Water Logger Software" CD-ROM (accessory).

Hardware and software requirements: refer to CD product insert.

9.1 Installing the OTT Water Logger Operating Program

How to install the OTT Water Logger Operating Program

Insert the OTT Water Logger Software CD-ROM into the PC drive.

In the "\Software\Deutsch" ! directory, start the "setup.exe" file (by e.g. dou-
ble clicking the file symbol) — The Setup Assistant opens and guides you
through the installation.

Follow the installation instructions on the screen.

1 Alternatively: change to the "\English", "\Francais", or "\Espafiol" directories.

9.2 Establishing the PC/OTT ecolLog 800 (3G) communication link
(on site)

In the following chapters, establishing a communication link between the

OTT ecolog 800 (3G) and a PC is described, which is a pre-requisite for the sub-
sequent steps. The following description illustrates the various methods of estab-
lishing this communication link.

The communication between the OTT ecolog 800 (3G) and a PC is established
contact-less via invisible infrared light (IrDA interface).

Required accessories:

OTT IrDA-Link USB reading head

How to establish a communication link

Start the operating program.

Change the language for the operating program as required:

press F3 function key (multiple times) until the required language appears.

In the start window, press the "Setup device" button — The operating program
displays the "Basic operation" window. No operating parameters for the
OTT ecolog 800 (3G) are visible yet.

Connect the OTT IrDA-Link USB reading head to a USB port on the PC. (USB
interface drivers must be installed, refer to separate installation instructions.)
Place the OTT IrDA-Link USB reading head onto the OTT ecolog 800 (3G)
infrared interface, refer to Fig. 15.

In the operating program, select the communication path "IrDA OTT IrDA-Link".

Notes

The built-in infrared interface of a PC (standard for many notebooks) can only
be used with the Windows 95 and Windows NT operating systems!



Fig. 15: PC/OTT ecolog 800 (3G)
communication link.

9.3 Establishing the communication link from remote
(OTT ecolog 800)

Note

A remote communication connection can only be established with the

OTT ecolog 800 (not the OTT ecolog 800 3G)!

In a 3G cellular network (UMTS/HSPA+), this is no longer possible for tech-
nical reasons. The circuit-switched service required for this purpose, i.e. CSD
(Circuit Switched Data) is no longer available in 3G cellular networks.

If both, installation and configuration of the OTT ecolog 800 have been completed
the communication link may also be established using the cellular network, e.g.
for future modifications to the configuration. To perform these operations, the PC
on which the operating program is executed must be connected to a wired or
GSM modem. For more information, please refer to online help.

Please note: Establishing a communication link using the cellular network may
take up to a minute!
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9.4 Seiting OTT ecolog 800 (3G) operating parameters

How to set the OTT ecolog 800 (3G) operating parameters

Click the "Connect" button (alternatively: menu "OTT ecolog 800 (3G)",
"Connect" function) — The operating program will read the current operating
parameters of the OTT ecolog 800 (3G).

Sefting operating parameters, refer to pages 27/28.

Optionally: "Set up cyclic data transmission via SMS" or "Set up cyclic data
transmission via GPRS(/3G)", refer to pages 26/27.

Set date/time: Accept the proposed PC date/time or individually set the
date/time using the "Set date/time" function, also refer to Chapter 15.
Please note: The operating program automatically corrects any Daylight
Saving Time sefting on the PC.

Click the "Save to device" button — "Warning: Reset OTT ecolog 800 (3G)
and delete data memory additionally2" Confirm by clicking "Yes" (recommend-
ed for initial installation and reinstallations).

Please note: All measured values collected so far will be permanently lost!
Check the level of the measured value set (pressure sensor),

refer to Chapter 10.

Remove the OTT IrDA-Link USB reading head.

Close the top cap/observation well cover.

Setting up the cyclic data transmission via SMS ")

Enable the "SMS data transmission active" check box.

If necessary: Enable the "Authorize Roaming " and/or "Store GSM signal
strength" check boxes.

Click the "Settings modem" button — The operating program starts a wizard
for setting all the necessary operating parameters.

Enter the receiver phone no. for the data SMS (phone number of a large
account or for a PC connected to a cellular modem).

Click the "Next" button.

If necessary: enter SIM PIN (4-digit) of the SIM card.

Click the "Next" button.

Set or enter the SMS-C phone no. of the network operator (phone number of
the SMS service center. By default, the SMS-C phone number is already saved
on the SIM card — In this case, set to "SIM card".)

Click the "Next" button.

Select the mode of the SMS transmission.

Click the "Next" button.

Set the inferval for transmitting the stored values.

Click the "Next" button.

Set the offset time for the transmission interval.

Click the "Exit" button.

Finally check the settings and correct as necessary.

Click the "OK" button.

! For further information, refer to online help.



Setting up the cyclic data transmission via GPRS(/3G) "

Enable the "GPRS(/3G) data transmission active" check box.
If necessary: Enable the "Authorize Roaming " and/or "Store GSM signal

strength" check boxes.

Click the "Settings modem" button — The operating program opens a window
displaying several tabs for setting all the necessary operating parameters.
Make the required seftings in the "General", "Operator”, "FTP" and "Time
sync." tabs. Please note: The SIM PIN for the SIM card used should be dis-
abled! Otherwise enter the SIM PIN for advanced operation in the

"Modem/ITC" tab.
Click the "OK" button.

1 For further information, refer to online he|p4
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Fig. 16: Setting the OTT ecolog 800 (3G) operating parameters using the OTT Water Logger Operating Program.
The "Advanced operation ..." button is only visible, if the "Advanced operation ..." check box is enabled in the "Options" window.
The figure shows, as an example, the window for setting up the OTT ecolog 800 operating parameters.

OTT ecolog 800 (3G)
Site number
Site name

station number, 10 characters (alphanumeric)
station name, max. 40 characters (a|phanumeric)
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Water level/pressure - temperature

Parameter number sensor number, 4 characters (alphanumeric)
Parameter name sensor name, max. 40 characters (alphanumeric)
Measurement type/Meas.range Water level: depth or level - pressure

- Conductivity 0.001 ... 2.000 mS/cm - 0.10 ... 100.00 mS/cm
— Salinity: 2 ... 42.00 PSU - 2 ... 60.00 ppt
Unit + — Pressure sensor: m, cm, feet, inch / bar, psi
- Temperature: °C - °F
- Conductivity: mS/cm - pS/cm
- Salinity: PSU - ppt
- TDS: mg/I
Decimal places fixed specification, depending on the units and measuring range
-m:3or2;cm: 10or0; feet: 2or 1; inch: 1 or 0
—bar: 4 or 3; psi: 3 or 2
-°C:2o0r1,°F:2o0r1
-mS/cm: 3 or 2; pS/cm: 3

- PSU: 2; ppt: 2
-mg/l: 2
Depth to water — set newly For the "Water level - depth" measurement type: [/] Enter contact gauge value
Water level - set newly For the "Water level - level" measurement type: Enter staff gauge value
(reference to level zero)
Pressure value — set newly For the "Pressure" measurement type: Enter reference pressure
Sample interval 55 ... 24 h: time delay at which the OTT ecolog 800 (3G) records measured val-

ves and stores them (store only, if sample interval = mean interval). The sample
interval is set to a fixed time pattern (e.g. sample interval of 10 minutes, time pat-
tern ..., 00:10, 00:20, 00:30, ... .

Storage interval 55 ... 24 h: time period for which the OTT ecolog 800 (3G) calculates an arith-
metic mean from the sample interval values and stores it. The storage interval must
be equal to or larger than the sample interval. The sample interval must be con-
tained in the storage inferval as an integer number (e.g. sample interval: 10 min-
utes; storage inferval: 1 hour — Every hour, the OTT ecolog 800 (3G) stores an
arithmetic mean from 6 sample interval values).

Authorize Roaming Allows the cellular modem to book into other, external cellular networks (not only
into the cellular network specified by the SIM card). This might be of importance in
regions that are located close to a border, in which a foreign cellular network may
have better coverage but is more expensive.

SMS data transmission active Refer to "Setting up the cyclic data transmission via SMS".

GPRS data transmission active Refer to "Setting up the cyclic data transmission via GPRS(/3G)"; 3G data trans-
GPRS/3G data transmission active  mission (UMTS/HSPA+) is only available with the OTT ecolog 800 3G

Store GSM Signal strength Stores the GSM signal strength in a separate channel. The sample interval in this

channel is 24 hours (factory sefting: Storage delta = 1); irrespective of this, the
OTT ecolog 800 (3G) saves 1 value per day in any case.

Additional settings for conductivity, salinity and TDS

Temperature compensation the mathematical algorithm on which the calculation of the specific conductivity at

(Conductivity) a defined reference temperature is based. Possibilities: "Freshwater"; Saltwater";
Standard method 2510"; "ISO 7888/EN 27888"; "---" (none). For the "Standard
method 2510", the reference temperature can be selected: 20 °C or 25 °C.

Calculation method the mathematical algorithm on which the calculation of the salinity is based. Possi-

(Salinity) bilities: "Standard method"; "USGS 2311". With the calculation method USGS
2311, the unit is "ppt"; with the standard method the unit "PSU" is fixed.

Store salinity With the check box activated, the datalogger saves the values. With the check box

Store TDS deactivated, the instantaneous values are still visible in the observer window.
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Other displays in the "Basic operation" window

Measuring range
System length
Date/time

Battery lifetime (button)

Measuring range of the pressure probe, refer to Fig. 1.

Cable length including communication unit/pressure probe, refer to Fig. 1.

Internal date/time of the OTT ecolog 800 (3G).

The operating program calculates the approximate life of the different battery
types based on the seftings made (at =20 and +20 °C ambient temperature in

each case).

Detailed information on the "Advanced operation” function can be found in the online help.

Factory settings

OTT ecolog 800 (3G)

Site number OTT ecolog 800 (3G) serial number
Site name ecolog 800 1

Water level/Pressure Temperature
Parameter number 0001 0002
Measurement type Water level - depth
Unit m °C
Decimal places 2 2
Sample interval 1h Th
Storage interval 1h 1h

Conductivity Salinity DS
Number 0004 0005 0006
Name Specific Conductivity Salinity DS
Unit mS/cm PSU mg/|
Decimal places 2
Measuring range 0.10 ...100.00 mS/cm 2 ... 42.00 PSU
Temperature compensation Fresh water
Calculation method Standard method
Sample interval 1h Th Th
Storage interval 1h Th Th
Modem connected Enabled
Authorize roaming Disabled
SMS data transmission active Disabled
GPRS(/3G) data transfer active Disabled
Store GSM signal strength Disabled

In addition, the OTT ecolog 800 (3G) records the supply voltage at a sample and storage interval of 1 hour (refer to online

help).
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9.5 Saving/loading an OTT ecoLog 800 (3G) configuration

The "Load from PC" and "Save to PC" functions are designed to archive the

OTT ecolog 800 (3G) configuration on a PC. For example, you may configure
multiple OTT ecolog 800 (3G) units using the same configuration. Additionally,
the "Load from PC" and "Save to PC" functions are required when using the "SMS
command" function (refer to online help).

How to save a configuration

From the "File" menu, select the "Save configuration” function (or use the but-
ton) — The operating program saves the configuration under the name and
number of the OTT ecolog 800 (3G). When changes are made fo a configura-
tion that has already been saved, confirm by clicking "Yes" in the window
"Warning. This configuration name already exists! Replace?" (otherwise, save
the configuration under another station number).

How to load a configuration

From the "File" menu, select the "Load configurotion" function

(or use the button).

For an already opened configuration, confirm "Ignore changes2" message by
clicking "Yes" (if necessary, save configuration in advance).

In the "Stored OTT ecolog 800 (3G) configurations" window, select the config-
uration by double-clicking it = The operating program loads the configuration.

9.6 Importing/exporting an OTT ecoLog 800 (3G) configuration

To transfer an OTT ecolog 800 (3G) configuration e.g. via USB flash drive or e-
mail, the Import/Export functions are available. Similarly, a configuration can be
sent via the Export function as an XML file to the OTT Hydras 3 user software.
During this process, the OTT Hydras 3 user software creates the entire station/sen-
sor configurations in an OTT Hydras 3 operating range.

Available export/import formats

Export ("BIN" file)
Export fo a text file
Export for the OTT Hydras 3 user software

Import ("BIN“ file)
The operating program stores all the necessary data of a configuration in a single
"+ BIN", "=.TXT" or "* XML" file, depending on the export type.
How to export a configuration ("+.BIN" file)

This export type is required to transfer an OTT ecolog 800 (3G) configuration as
a "*.BIN" file. Using the "Import configuration" function, the configuration can be
read back into the operating program.

From the "File" menu, select the "Export configuration" function.

In the "OTT ecolog 800 (3G) — export configuration" window, edit the file
name, if necessary, select the storage location, and click "Store" — The operat-
ing program saves the configuration in a "*.BIN" file.

Note

The file name of the "+.BIN" file is arbitrary. The operating program suggests a
combination of station number and station name.



How to export a configuration (text file)

This export type is required to transfer an OTT ecolog 800 (3G) configuration for
documentation purposes as a "+ TXT" file. This "+.TXT" file can be opened by
means of any text editor or word processing program.

From the "File" menu, select the "Export text file" function.

In the "OTT ecolog 800 (3G) - configuration" window, edit the file name, if
necessary, select the storage location, and click "Store" — The operating pro-
gram saves the configuration in a "«.TXT" file.

Note

The file name of the "+.TXT" file is arbitrary. The operating program suggests o
combination of station number and station name.

How to export a configuration (OTT Hydras 3)

This export type is required to transfer an OTT ecolog 800 (3G) configuration to
the OTT Hydras 3 user software. This "+ XML" file is read in via the Hydras 3
function "File", "Import Station Configuration (XML)".

From the "File" menu, select the "Export Hydras 3 (XML)" function.

In the "OTT ecolog 800 (3G) — XML configuration" window, check the file
name, select the storage location, and click "Store" — The operating program
saves the configuration in a "+ XML" file.

Note

The file name of the "+ XML" file is arbitrary. To avoid affecting later data
transfer, it should not be changed. The operating program proposes a combi-
nation of station number and station name along with the ending "+.STA-
TION.XML".

How to import a configuration

From the "File" menu, select the "Import configuration" function.

For an already opened configuration, confirm "Ignore changes2" message by
clicking "Yes" (if necessary, save configuration in advance).

In the "OTT ecolog 800 (3G) configuration import" window, select the appro-
priate "*.BIN" file and click "Open" — The operating program reads in the
configuration from the *.BIN" file. (Prior fo this, save any configuration that is
already open).

Note

The factory default configuration is found on the "OTT Water Logger Software"
CD-ROM.
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Fig. 17: Input window fo establish options
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for the observer.

For further information on protecting the
operating program by means of a pass-
word refer to Chapter 14.

10 Determining and displaying instantaneous values
(Observer function)

For determining and displaying instantaneous values, the operating program
includes a so-called "Observer". The Observer also allows a manually determined
measured value, e.g. contact gauge value, to be entered into the datalogger
(Observer registration).

Various options can be set concerning the observer:

Options in the start window of the operating program:

— Directly and exclusively opening the Observer, or

— Opening of a window to set the operating parameters

Effect of an optionally entered Observer registration (pressure sensor):

— The Observer registration is only used as a check value or

— the Observer registration leads to a value change (set offset)

Suppress the display of the instantaneous value (pressure sensor) prior to enter-
ing an observer registration.

As an dlternative to the following procedure, you may use a cellular phone to
show instantaneous values by SMS messages or to make observer entries. This
requires the "SMS info" feature to be enabled and set up. For more information,
please refer to online help in the operating program.

How to set the Observer options

Start the operating program.

From the "File " menu, select the "Options" function. (If the option dialog can-
not be called, a password must first be entered. Refer to Chapter 12.)

Enable the checkbox(es) of the required Observer option(s):
- [ Only observer mode
- [ Do not calculate manual input value with scaling

(only check value/no value change);

— [/ Suppress display of instantaneous value before input;
Click the "OK" button.

m Options

i~ General

I Advanced operatioti ...

Passward |

i~ Observer

™ Only ohserver mode
I Donot calculate manual input value with scaling

[T Suppress display of instantaneaus value before input

oK |

The combination of "Only observer mode" and a password protects the operating
program against unauthorized input of operating parameters.

The "Advanced operation..." option displays an additional button in the window
for setting the operating parameters.



Fig. 18: Display/input window "OTT Water
Logger Operating Program — Observer".

The window displays the current
instantaneous value for all measurements.
Furthermore, the window displays the sensor
number/name, the current bcmery vo|tage,
the amount of power used from the batteries
up to now, and the date and time.

How to open the Observer function

Start the operating program.

Establish the PC/OTT ecolog 800 (3G) communication link, refer to Chapters
9.2 or 9.3.

Depending on the option set: In the start window of the operating program,
either select "View Instantaneous values" or "Setup device" and in the sub-
sequent window, select the "View Instantaneous values" function in the

"OTT ecolog 800 (3G)" menu — The OTT ecolog 800 (3G) starts an instan-
taneous value measurement and the "Observer" window opens:

m OTT Water Logger Operating Program - Observer | x|

ecolog 500/ 0000301162 3.6 /2857 Ah 21.03.201217:30:51

Waater lewel f 0001 |4.SDD 4420 m

Observer registration with value change

Temperature § 0002 10070 °C

Specific Conductivity / 0004 2204 m3/cm

Salinity / 0005 1458 ppt

TOS { 0006 1410 mo/l

Supplywoltage / 0003 36 W
Stare Refresh Exit

™ Automatic refresh

If necessary: Input Observer registration into the entry field of the pressure sen-
sor and click on the "Store" button.

If necessary: Start new instantaneous value measurement: click on the "Refresh"
button ("[7] Automatic refresh" starts an instantaneous value measurement
every 5 seconds).

Exiting the Observer: Click the "Exit" button and close the operating program.

Notes

The OTT ecolog 800 (3G) stores each call of the Observer function in an info
channel with date and time. After reading in and accepting into the OTT
Hydras 3 user software, this information can be displayed in the evaluation
window of a sensor using the "Info Data" > "Station" > Displays" function
("Observer registration general"). Similarly, they are visible via the "View
data" > "Table" function of the operating program.

If the "[7] Do not calculate manual input value with scaling" check box in the
"Options" window is enabled, the OTT ecolog 800 (3G) also saves the input
check value as well as the current instantaneous value. After reading in and
accepting into the OTT Hydras 3 user software, this information can be dis-
played in the evaluation window of a sensor using the "Info Data" > "Sensor"
> "Displays" function ("Observer registration with check value). Similarly, they
are visible via the "View data" > "Table" function of the operating program.
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Fig. 19: Downloading data.

1 Reading data

How to read data (on site)

Start the operating program.

Establish the PC/OTT ecolog 800 (3G) communication link, refer to Chapters
9.20r9.3.

Press the "Download data" button in the start window — The operating pro-
gram displays the available sensors and the possible period for downloading
in the "Download data" window. If these values are not visible: Press the
"Connect" button.

Select the desired sensors or "All sensors".

Select the desired read period or "All". (The row above the entry field shows
the complete time period for which there are data.)

Click the "Connect" button — The operating program copies the measured val-
ues from the OTT ecolog 800 (3G) to the PC. The data is then available in the
raw data directory of the operating program.

If necessary: Change to the "View / Export data” function to display/export
measured values and/or to export to another software application.

Click the "Main menu" button.

2 01T Wates Logger Operating Program - Download data [_ [l =]
File Help
0000301162 (OTT ecolog 6000

o001

oooz

0004

0003

ooo?

All sensors
o1o12m2 21.03.2012
olozzmz x| oAl 21.032mz2 x
Download data | Catie| |

Wiew / Export data |

— OTT Dipheus Mini # OTT CTD 4 OTT ecolag
Ir0A -OTT DuoLink bl
Connect M ain menu
COMT: ] |57600 =

Possible alternatives for downloads:

Using the operating program and a cellular network

(OTT ecolog 800)

In conjunction with a modem connected to the PC, a communication link may
be established via a cellular network (read data remotely), refer to online help.
Note: A remote communication connection can only be established with the
OTT ecolog 800 (not the OTT ecolog 800 3G)!

In a 3G cellular network (UMTS/HSPA+), this is no longer possible for
technical reasons. The circuit-switched service required for this purpose, i.e.
CSD (Circuit Switched Data) is no longer available in 3G cellular networks.

Using the "OTT Hydras 3 (Basic)" application software

From the tree, select the desired station by double clicking it. In the following
window, make the necessary settings and click the "Start" button. For further
information, see the online help for the OTT Hydras 3 (Basic).




12 Exporting data

After downloading to the operating program, the measured value and information
data can be found in the "RAWDATA" sub-directory of the program directory
(default setting: "C:\Program files\OTT\OrpheusMini_CTD\RAWDATA"). To
transfer to an external application, you may export the data in various formats:

CSV - Structured text file in CSV format (Comma-Separated Values);

Excel — Microsoft Excel spreadsheet program;

OTT Hydras 3 — Raw data format for the OTT Hydras 3 user software;

OTT MIS - OTT-specific file format for automatically importing into the mea-
surement database of the OTT Hydras 3 user software.

Using the "Export options" dialog window, you may set the location for saving
and, for the CSV format, various export parameters. The data will remain avail-
able in the sub-directory after export. If required, you may explicitly delete it.

Info data can only be exported to the OTT Hydras 3 user software.

How to export the data
Step 1 - Make export settings:

Click the "View / Export data" button in the start window.

In the "View / Export data" window, click the "Export options" button (refer to
Fig. 20).

Set the path to the location of the required export format (default setting:
"C:\Program files\OTT\OrpheusMini_CTD\Export"). No path can be set for
the Excel format: The operating program automatically opens Microsoft Excel
during export and displays the data in a new workbook. For the "Hydras 3"
format, the "2" button can be used to automatically find the installation directo-
ry of OTT Hydras 3.

For the "CSV" format: set "Field separator", "Dec. separator", "Date format",
and "Time format". For the date and time formats, the typical Windows place-
holders may be used.

Step 2 - Export data:

From the list, select the desired station/sensor (multiple selections possible).
Click the "Export ..." button.

Confirm the message about successful export by clicking "OK".

If required, delete the exported data: Click the "Delete" button.
(Station/sensor must still be selected.)

Confirm the message by clicking "Yes".
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Fig. 20: Viewing/exporting data.

13 Displaying data

After downloading to the operating program, the measured value and information
data can be found in the "RAWDATA" sub-directory of the program directory
(default setting: "C:\Program files\OTT\OrpheusMini_CTD\RAWDATA"). For an
initial check, you may display the data graphically and numerically and print
them, if required.

How to display data graphically

Click the "View / Export data" button in the start window.

From the list, select the desired station/sensor (multiple selections possible - a
maximum of é will be displayed; info data can only be displayed numerically).
Click the "Graphic" button — The operating program displays the window pre-
senting the graphical view of the selected data;

— Show ruler: "F12" function key. Move ruler: Arrow keys < —.

— Zoom in: Use the mouse to drag the desired area.

— Zoom out: "F12" function key.

Print graphic: From the "File" menu, select the "Print" function.

Close graphic: From the "File" menu, select the "Exit" function (or [X]).

How to display data numerically

Click the "View / Export data" button in the start window.

From the list, select the desired station/sensor (multiple selections possible, a

maximum of 6 will be displayed).

Click on the "Table" button — the operating program displays the window with

the numerical view of the data in the OTT data protocol;

- Only display measured values: select "Values".

— Highlight special areas (only with information data): Select "Observer &
operation”, "Alarm & limit", "Communication & faults", "Faults & service
log".

Printing the numerical display: From the "File" menu, select the "Print" function.

Closing the numerical display: Select the "Exit" button (or [X]).

How to delete data

From the list, select the desired station/sensor (multiple selections possible).
Click the "Delete" button.
Confirm the message by clicking "Yes".

R 01T Water Logger Operaling Program - View / Export data [_ ] %]
File Help

Station TO-Date

27.03.2012
0000301162 (ecolog &00) 21.03.2012 Graph
0000301162 (ecolog 500) 0003 01.03.2012 21.03.2012

0000301162 (ecalog 600) 0004 01.03.2012 21.03.2012 T abie
0000301162 (ecalog 600) 0007 01.03.2012 21.03.2012

0000301162 (ecalag 600) INFO 01032012 21.03.2012 —

Export CSY
Expart Excel
Expoit OTT MIS
Export Hydras 3

Expoit Options

b ain menu

nonz




14 Protecting the OTT ecolog 800 (3G) unit and the
OTT Water Logger Operating Program using a
password

To prevent unauthorized input of operating parameters, you may protect

the OTT ecolog 800 (3G) unit and
the operating program:

using a separate password for each.

How to protect the operating program using a password

Start the operating program.

From the "File" menu, select the "Options" function.

Enter an eight-digit (max.) password into the "Password" input box. Allowed
characters 0 ... 9, A ... Z. (This password is independent of the

OTT ecolog 800 (3G) password.)

Enable the "Only observer mode" check box.

Click the "OK" button.

Close the operating program — The operating program is now protected: The
"Setup device" button in the start window is no longer visible.

Fig. 21: Protecting the operating program B Options
by means of a password - Input window ~ General
for defining a password.

[ #dvanced operation ..

A password protected operating program is Passmard [PaSSwORD
reasonable only if the operating program
starts in Observer mode ("Only observer
mode" check box enabled)! W Only observer mode

[~ Do not caleulate manual input value with scaling

i~ Observer

™ Suppress display of instantaneaus value before input

0K |

Please note:

If the password is lost, you can no longer configure or parameterize the OTT
ecolog 800 (3G) on this PC. If this occurs contact OTT HydroService.

The password assigned here only applies to the operating program installed on
this PC. The OTT ecolog 800 (3G) unit is not protected by this password!

How to unlock a password-protected operating program

Start the operating program.
From the "File" menu, select the "Options" function.
Enter the password into the "OTT ecolLog 800 (3G)" window.

Fig. 22: Unlocking the operating program - [FTEeeTeee]

Password input window.
Enter password [0..9.4.2)

ok I Cancel
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Fig. 23: Profecting the OTT ecolog 800 (3G)
by means of a password — Input window for

38

defining a password.

Fig. 24: Unlocking the
OTT ecolog 800 (3G) -

Password input window.

Click the "OK" button.

Disable the "Only observer mode" check box.

Remove the entry from the "Password" input box.

Click the "OK" button — The operating program is no longer password
protected.

How to protect the OTT ecolLog 800 (3G) using a password

Start the operating program.

Establish the PC/OTT ecolog 800 (3G) communication link, refer to Chapters
9.20r93.

Click the "Setup device" button in the start window.

Click the "Advanced operation ..." button.

(Button not visible2 — Enable the "Advanced operation ..." check box

in the "Options" function in the "File" menu.)

Click the "Connect" button.

From the tree view, select "Communication Interface".

Enter a password of maximum eight characters into the "OTT ecolog 800 (3G)
password" input box. Allowed characters O ... 9, A ... Z. (This password is
independent of the operating program password.)

Click the "Save to device" button.

Warning: "Reset OTT ecolog 800 (3G) and delete data memory additionally?"
Confirm by clicking "No" — The OTT ecolog 800 (3G) is now protected
against unauthorized operation.

— Communication interface
General Modem.-"ITEI SMS data | GRPS data | SMS Info

Password OTT ecolag 800 |

Please note: If the password is lost, you can no longer configure or parameter-
ize the OTT ecolog 800 (3G). If this occurs contact OTT HydroService.

How to unlock a password-protected OTT ecoLog 800 (3G)

Start the operating program.

Establish the PC/OTT ecolog 800 (3G) communication link, refer to Chapters
9.20r9.3.

Click the "Setup device" button in the start window.

From the "OTT ecolog 800 (3G)" menu, select the "Enter password" function.
Enter password.

Click the "OK" button.

Confirm the "Password accepted! OTT ecolog 800 (3G) unlocked" message by
clicking "OK".

Click the "Connect" button —+ The operating program downloads the current
OTT ecolog 800 (3G) operating parameters.

OTT ecolog 800

Enter password [0.9.4. )

0K I Cancel




Fig. 25: Setting the OTT ecolog 800 (3G)

date and time.

15 Setting date and time

The internal clock of the OTT ecolog 800 (3G) is a high-accuracy realtime-clock.
It runs as soon as batteries are installed in the OTT ecolog 800 (3G). After the
batteries are removed, the clock will continue to run for approximately 10 min-
utes. After a longer period of power loss, the OTT ecolog 800 (3G) will lose the
date and time. When batteries are reinstalled, the OTT ecolog 800 (3G) adopts
the date and time of the last stored measured value, with one minute added to the
stored time. The date and time are set using the operating program.

How to set the date and time

Start the operating program.

Establish the PC/OTT ecolog 800 (3G) communication link, refer to
Chapters 9.2 or 9.3.

Click the "Setup device" button in the start window.

Select the "Date/time" function in the "OTT ecolog 800 (3G)" menu — The
operating program reads the date and time from the OTT ecolog 800 (3G)
and opens the "OTT ecolog 800 (3G) - date/time" window.

mDTT Water Logger Operating Program - Date / time

OTT ecolog 800 01/09/2011 09:39:43 Refresh |
PC [D5T) 0140942011 10:40:08
Set datetime |
|£DS£2D11 'I |DS:4D:12 :‘

Exit |

If necessary: click the "Refresh" button — The OTT ecolog 800 (3G) reads the
date and time again.

If necessary: Adjust the desired values in the two input fields.

Click the "Set date/time" button — The operating program sets the

OTT ecolog 800 (3G) date and time to the PC time/date or to the values set.
Click the "Exit" button.

Please note: If the PC is in Daylight Saving Time (ID: PC (DST)), the operating
program automatically uses the standard time without DST correction. To obtain
continuous time series, it is a good idea not to use Daylight Saving Time in the
OTT ecolog 800 (3G).

In connection with a GPRS(/3G) remote data transfer and the "Time synchroniza-
tion" function, it is necessary to reference the time to UTC/GMT and to set the
time zone of the station in the "Advanced operation”, "OTT ecolog 800 (3G)"
window, refer to online help.

Note

When the unit is put back into service, it may be appropriate to erase the data
memory after having set date and time, refer to Chapter 16.
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16 Erasing the data memory

Please note: After erasing the data memory, the measured values stored in the
OTT ecolog 800 (3G) are permanently lost! If necessary download measured val-
ves before erasing!

How to erase the data memory

Start the operating program.

Establish the PC/OTT ecolog 800 (3G) communication link, refer to Chapters
9.20r9.3.

Click the "Setup device" button in the start window.

Select the "Delete data memory" function in the "OTT ecolog 800 (3G)" menu.
Acknowledge the "Are you sure you want to delete data memory2" warning by
clicking "Yes"— The operating program erases the complete data memory of
the OTT ecolog 800 (3G) (all measurement channels including the info chan-
nel). The OTT ecolog 800 (3G) then determines and stores the water level, the
water temperature and the specific conductivity again using the sample interval
seftings set.

17 Updating the OTT ecolLog 800 (3G) firmware

If required, you have the option of updating the OTT ecolog 800 (3G) firmware
(operating system software). This makes sense, if e.g. devices delivered ot different
times are fo receive the same operating system version. Updating is carried out
via the operating program. According to availability, an updated version of the
OTT ecolog 800 (3G) firmware can be found on the internet site "www.ott.com"
in the "myOTT" area.

How to update the firmware

Download the new version of the firmware (File: e.g. "5544730293_02001-
_el800NG.bin" or "5544930293_01000_el800NG.bin") from the internet site.
Move the file "5544730293_XXXXX_el800NG.bin" or "5544930293_XXXXX-
_elBOONG.bin" to the directory, in which the operating program is located.
Establish the PC/OTT ecolog 800 (3G) communication link, refer to

Chapters 9.2 or 9.3.

From the "OTT ecolog 800 (3G)" menu, select the "Firmware update" function.
Confirm message by clicking "Yes" — The operating program copies the new
firmware to the OTT ecolog 800 (3G). The OTT ecolog 800 (3G) then deter-
mines and stores the water level, the water temperature and the specific con-
ductivity again using the sample interval settings set.

Please note: During updating process, avoid breaking the communication
link (e.g. by accidentally removing the OTT IrDA-Link USB from the infrared
interface of the OTT ecolog 800 (3G)). If the communication link is aborted,
the firmware will no longer be executable! Similarly, no other programs should
be started or files opened during the copying process!

Notes

If there are multiple ".bin" files in the directory you will have to select the
required file manually.

The measurements saved in the OTT ecolog 800 (3G) are not lost affer an
update.



Fig. 26: Cleaning the pressure probe.

18 Maintenance work

18.1 Cleaning the pressure probe

Recommended interval: Every 12 months
In case of difficult local measuring conditions (heavy
deposits): as required every 4 to 6 months.
(Measurements that are inaccurate or not p|ausib|e
indicate a contaminated pressure sensor.)

How to clean the pressure probe

Open the top cap/observation well cover.

Completely remove the OTT ecolog 800 (3G) from the observation well.
Remove the black protective cap.

Clean the pressure sensor carefully using a brush and water. Clean graphite
electrodes and temperature sensors for the conductivity sensor with soapy
water and cotton buds. Lime scale deposits can be removed using a common
household scale remover. Make sure to follow the use and safety instructions
for the scale remover!

Rinse the pressure probe thoroughly with clear water!

Reattach the black protective cap.

Recommendation: Calibrate the conductivity sensor (see Chapter 18.4).
Reinstall the OTT ecolog 800 (3G), refer to Chapter 8.

Determine current reference value by means of a contact gauge and enter it,
refer to Chapters 9.4 or 10.

Close the top cap/observation well cover.

Pressure probe with Temperature sensor
conductivity sensor
and datalogger

Black

profective cap Graphite  Conductivity

electrodes sensor

Pressure Sensor
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Fig. 27: Replacing the pressure
probe desiccant capsule.

18.2 Replacing the desiccant capsules

Recommended inferval: Depending on the level of air humidity at the station,
every 12 to 24 months and when replacing the batteries.
There is a humidity indicator on the desiccant capsule.
When this indicator changes its color from blue to pink
the desiccant capsule has to be replaced, irrespective of
the time elapsed.

Quantity: 2 (1x pressure compensation capillary,

1x communication unit).

Notes

Store the desiccant capsule only in its original packaging.
Use only desiccant capsules that are fitted with a blue humidity indicator.

How to replace the desiccant capsules
A) Desiccant capsule for pressure compensation capillary

Open the top cap/observation well cover.

Pull and hold the communication unit approximately 1 m out of the observation
well (a second person would be useful).

Remove the screw fitting from the communication unit.

Slide the cap and pipe casing of the communication unit approx. 50 cm
towards the pressure probe cable. (The rubber stop located on the pressure
probe cable (refer to Fig. 2) prevents the pipe casing from falling.)

Pull the desiccant capsule container of the pressure compensation capillary
from the holder, as shown in Fig. 27.

Remove the cap of the container by rotating it counter-clockwise.

Remove the exhausted desiccant capsule.

Install new desiccant capsule. Labeling must face towards pressure compensa-
tion capillary.

Install the cap by rotating it clockwise.

Reinsert the container into the holder.

Container for  Pressure compensation capillary
desiccant capsule desiccant capsule Cap

Pressure compensation capillary




Fig. 28: Replacing the communication
unit desiccant capsule.

B) Desiccant capsule for communication unit

Remove the exhausted desiccant capsule of the communication unit, as shown
in Figure 28.
Install new desiccant capsule.

N

Communication unit
desiccant capsule

40%

S ———

N A

Slide the pipe casing of the communication unit back up to the stop.

Please note: Do not bend or pinch the battery lead.

Reinstall the screw fitting to the communication unit.

Slowly and carefully reinsert the communication unit into the observation well.
Close the top cap/observation well cover.

18.3 Checking/replacing the batteries
Refer to Chapter 5

18.4 Calibrating the conductivity sensor

The goal of the calibration is to determine the so-called "cell constant" for the con-
ductivity sensor. To do this, it is necessary to check the zero point and to carry out
a conductivity measurement with a standardized calibration solution.

The cell constant — as well as the unchanging geometric measurements, the mate-
rials used and the construction of the conductivity sensor — takes account of the
aging process of the electrodes.

Recommended interval: every 12 months (after every cleaning)
with difficult local measuring conditions (heavy deposits):
as required every 4 to 6 months

Required accessories:  standardized calibration solution, calibration container
(see Chapter 2, "Order numbers")
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Caution: For an optimum calibration process, the OTT ecolog 800 (3G) and the
calibration solution must be at the surrounding temperature!

How to calibrate the conductivity sensor

Carefully clean the pressure probe and dry well (see Chapter 18.1).

Start the operating program.

Set up the PC/OTT ecolog 800 (3G) communication link (see Chapter 9.2).

Press the "Setup device" button. (Button not visible2 — deactivate the "Only

observer mode" check box in the "Options" function in the "File" menu and

restart the operating program.)

Select the "Calibrate conductivity sensor" function in the "OTT ecolog 800 (3G)"

menu.

Press the "Start zero point test" button. The operating program starts an instan-

taneous value measurement and updates this every 5 to 6 seconds. If the mea-

surement result displayed (blue triangle) is not in the green area — clean the
conductivity sensor again and dry it well.

Press the "End zero point test" button.

Select the calibration solution used. Alternatively, select "Other ..." and enter

the appropriate conductivity value.

Add the cdlibration solution fo the calibration container (filling height approx. 3/4).

Place the OTT ecolog 800 (3G) into the calibration container (screw-on cover

in place) and tighten the screw-on cover by hand. Caution: There must not be

any air bubbles in the slot of the conductivity sensor! If necessary, lightly shake
the calibration container.

Press the "Start calibration" button. The operating program starts the instan-

taneous value measurement again and continuously updates it.

Wait until the values for conductivity and temperature do not change for sever-

al updates. The operating program displays the current and newly calculated

cell constant. Caution: Temperature values shown in red — the conductivity
sensor is not at the temperature of the calibration solution! New cell constant
shown in red — the cell constant lies outside the valid range.

Press the "End calibration" button.

Confirm the resulting question: "Save new cell constant?":

— cell constant is within the tolerance range — "No"

(conductivity value is in the green area)

— Cell constant is outside the tolerance range and within the valid range —
"Yes" (conductivity value is in red area + current cell constant is shown in
black)

If the cell constant is outside the valid range — error message.

Close the operating program.

Rinse the pressure probe thoroughly with clear water!

Reinstall OTT ecolog 800 (3G) (see Chapter 8).

Determine current reference value with a contact gauge and enfer it

(see Chapter 9.4 or 10).

Close the top cap/observation well cover.

Dispose of the used calibration solution!

Notes

Only use the calibration solution once!

Always store the calibration solution in a closed container! (The carbon dioxide
in the surrounding air and evaporation can change the conductivity value.)
Avoid water entering the calibration solution! Always dry the calibration con-
tainer carefully after calibration.

Calibration solution can be disposed of in the normal public sewer system!

The OTT ecolog 800 (3G) saves the last three cell constants in a history (see
"Advanced operation ...", channel "Conductivity").



19 Error messages

When faulty measurements or a malfunction occur, the OTT ecolog 800 (3G)
stores one of the following error messages in the data memory instead of a mea-

sured value.

Err 00
Err O1
Err 03
Err 05

Err 06
Err 10

Internal error (automated measurement)

Internal error (A/D conversion error)

Measuring range exceeded

An input value required for the measurement calculation is not in the

valid range (example: the temperature value needed for the calculation

of the salinity (standard method) is outside of the valid range :

0°C=t=<35.0°C)

An input value for the measurement calculation is missing

Measured value (still) not recorded; ,Err 10” indicates measured

values that are missing from the database and that

- have not yet been recorded, or

— could not be determined due to a short-term, temporary fault (in-
dividual measured values). As these faults cannot be avoided in all
cases due to technical reasons, they may also occur occasionally
during regular operation.

Internal errors indicate a device fault, if they occur repeatedly.

20 Troubleshooting/remedy

No communication possible
(operating program/OTT ecolog 800 (3G))

Password programmed?

— Enter correct password.

Battery installed?

— Install battery.

Battery exhausted?

— Replace the battery.

Pressure probe cable damaged?

— Send OTT ecolog 800 (3G) fo factory for repair.

Infrared inferface dirty?

— Clean the infrared interface carefully using a damp, soft cloth.

Sefting measured value not possible?

— Scaling module missing. Check configuration'!
(for advanced operation, refer to online help).

Communication starts and then aborts.

Battery exhausted?
— Replace the battery.
— Check pressure sensor for contamination. Clean as necessary.

1 The default factory configuration is located on the "OTT Water Logger Software” CD-ROM
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Faulty measured values

Temperature values faulty
— Check configuration” (for advanced operation, refer to online help).
Pressure sensor values faulty
— Check configuration'! {for advanced operation, refer to online help).
— Check the pressure compensation capillary in the communication unit
(blocked?). Clean as necessary.
Conductivity values erroneous
— check configuration" (for advanced operation, see online help).
— check conductivity sensor for contamination. If necessary, clean and then
recalibrate
Calculated salinity values erroneous (Err 05)
— check configuration" (for advanced operation, see online help).
— input value is outside valid range:
- salinity by standard method
1.0 °C =t < 35.0 °C for salinity 2.0 PSU < salinity < 42.0 PSU
— Salinity by "USGS 2311" method
0 °C =t = 30.0 °C for salinity 2.0 ppt < salinity < 60.0 ppt
Observer does not display calculated salinity values
— values lie outside the valid range:
— salinity according to standard method
2.0 PSU < salinity < 42.0 PSU
— salinity according to "USGS 2311" method
2.0 ppt < salinity < 60.0 ppt

No measured values in database

Configuration incorrect?

— Check configuration'! (for advanced operation, refer to online help).
Battery exhausted?

— Replace the battery.

Communication through cellular network not possible/
not successful

No transmission parameters (operator, etc) configured

— Check the operating parameters entered, refer to Chapter 9.4.

A remote communication connection cannot be established with the

OTT ecolog 800 3G

— this is not a malfunction. In a 3G cellular netzwork (UMTS/HSPA+), this is
no longer possible for technical reasons. The circuit-switched service required
for this purpose, i.e. CSD (Circuit Switched Data) is no longer available in 3G
cellular networks.

Battery exhausted?

— Replace the battery.

SIM card missing

— Insert the SIM card, refer to Chapter 6.

Incorrect PIN

— Check PIN, refer to Chapter 9.4.

GSM signal too low

— Check whether an external radio antenna should be used, refer to
Chapter 7.

No measured values present (by transmitting data)

—» Wait for the next data interval.

* The default factory configuration is located on the "OTT Water Logger Software" CD-ROM.



21 Repair

In case of a device malfunction, use Chapter 20, Troubleshooting/remedy to
see if you can resolve the problem yourself.

In case of device failure, please contact the OTT repair center (or alternatively
your local OTT sales representative):

OTT Hydromet GmbH
Repaircenter

Ludwigstraf3e 16

87437 Kempten - Germany
Phone +49 831 5617-433
Fax  +49 831 5617-439
repair@ott.com

Please note: Have a faulty OTT ecolog 800 (3G) checked and repaired only
by the OTT repair center. Never attempt to repair the unit yourselfl Any repairs or
attempted repairs carried out by the customer will void any warranty.

22 Notes about the disposal of old units

Within the member countries of the European Union

In accordance with the European Union guide|ine 2002/96/EC, OTT takes back
old devices within the member countries of the European Union and disposes of

them in an appropriate way. The devices concerned by this are marked with the
symbol shown aside.

For further information on the return procedure, please contact your local sales
contact. You will find the addresses of all sales partners in the internet on
"www.ott.com". Please take into consideration also the national implementation

of the EU guideline 2002/96/EC of your country.

For all other countries
After putting the unit out of service, properly dispose of the OTT ecolog 800 (3G).
Observe the regulations applicable in your country for the disposal of
electronic devices.
Never dispose of the OTT ecolog 800 (3G) in the normal domestic waste.

Materials used
Refer to Chapter 23, Technical data.
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23 Technical data

Water level
Measuring range

Resolution”

Accuracy (linearity + hysteresis)

Long-term stability (linearity + hysteresis)

Zero

Overload-resistant without permanent mechanical
damage (Pressure sensor)

0...0.4 bar

0...1 bar

0...2bar

0 ... 4 bar

0...10 bar
Units

Pressure sensor
Temperature-compensated operating range

Temperature
Measuring range
Resolution
Accuracy

Units

Power supply

Conductivity
Measuring ranges

Resolution
0.001 ... 2.000 mS/cm
0.10 ... 100.00 mS/cm
Accuracy
0.001 ... 2.000 mS/cm
0.10 ... 100.00 mS/cm
Units
0.001 ... 2.000 mS/cm
0.10 ... 100.00 mS/cm

Current consumption
Sleep mode
Read (IrDA)
Measuring operation
Mobile communication active, receiving
Mobile communication active, transmitting
Lifetime (1 hour sample interval, one transfer per day)
Lithium battery (26 Ah)
Lithium battery (13 Ah)
Clock
Design
Accuracy
Buffer period for battery replacement

0 4 m water column (O ... 0.4 bar)
0 ... 10 m water column (O ... 1 bar)
0 ... 20 m water column (0 ... 2 bar)
0 ... 40 m water column (O ... 4 bar)
0 ...100 m water column (O ... 10 bar)
0.001 m; 0.1 cm; 0.01 ft; 0.1 inch
0.0001 bar; 0.001 psi

+ 0.05 % full scale

+ 0.1 %/a full scale

+ 0.1 % full scale

4 bar

10 bar

15 bar

25 bar

40 bar

m, ft, inch, bar, psi, pascal
ceramic; iemperature-compensated
=5°C ... +45 °C |ice free)

-25°C ... +70°C
0.01 °C

+0.1 °C

°C - °F

Lithium battery, D type, 3.6 V / 13 Ah or
Lithium battery, DD type, 3.6 V / 26 Ah

0.001 ... 2.000 mS/cm
0.10 ... 100.00 mS/cm

0.001 mS/cm
0.01 mS/cm

+0.5 % of measured value (at least £0.001 mS/cm)
+1.5 % of measured value (at least +0.01 mS/cm)

mS/cm - pS/cm
mS/cm

110 pA
76 mA
65 mA
13 mA
160 mA

> 10 years minimum
> 5 years minimum

Real-time clock
+8 seconds/month (at +25 °C)

7 minutes max.

! For value ranges £32.750 m; £3275.0 cm; £327.50 ft; £3275.0 inch; £3.2750 bar; £32.750 psi
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Interface

Cellular network modems/frequencies

OTT ecolog 800

OTT ecolog 800 3G

SIM card
Radio anfenna

Temperature range, operating
Temperature range, storage

Air humidity

Data memory

Measurement memory

Number of measured values
Number of logical channels
Physical channels (input signals)

Sample inferval
Storage interval (mean interval)

Individually configurable functions

Mobile communications functions

SMS direct transmission
SMS command

Data retrieval via direct connection

GSM/GPRS functions
UMTS/HSPA+ functions

Infrared (IrDA)

GSM/GPRS

900/1800, 850/1900 MHz;

GSM/GPRS; UMTS/HSPA+

900/1800, 850/1900 MHz;

800/850, 900, AWS 1700, 1900, 2100 MHz

Micro-SIM (Mini-UICC; 3FF)

Built-in, robust and weather-proof; optional connection of an exter-
nal antenna is possib|e (SMA connection); max. permitted antenna
gain (incl. cable): max. 2.5 dBi.

A minimum distance of 0.20 metres must be maintained between the
radio antenna and people and between radio anfenna and other
electrical equipment/antennael!

-30°C ... +85°C
—40 °C ... +85°C
5% ... 95 % (non-condensing)

4 MB

Approx. 500,000

6 + 1 info channel
Water level/pressure
Temperature
Conductivity

Supply voltage

GSM signal strength
Minimum supply voltage during transmission via cellular network
5 seconds ... 24 hours
5 seconds ... 24 hours

- Basic or advanced operation

- 5 extended sample intervals with start/stop time indication,
support for pumping tests

- Selection of units

- Number of decimal places

— Pressure/level measurement or depth measurement

- With consideration of the local gravitational acceleration

- Compensate for water density using salinity and temperature

— Temperature compensation for conductivity. Options: Freshwater;
Saltwater; Standard method 2510 (reference temperature: 25 °C
or 20 °C); ISO 7888 / EN 27888; none

- Salinity (standard method or USGS 2311)

- Display of instantaneous values with level monitoring function

— Password protection

— Measured value processing: Calculation of mean; delta storage;
scaling function; extreme value storage; limit control of the sample
interval

— Virtual sensor/virtual terminal

- Alarm management

- Remote data transfer

OTT ecolog 800 OTT ecolog 800 3G
v/ v/
v 4
v -
v/ v
- v
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Mechanical Data
Can be installed in observation wells
= Top caps with cut-out (OTT, HT)
- With adapter plates for top caps
With cut-out (OTT, HT)
— With universal suspension brackets for top caps
Without cut-out/universal installation
Dimensions
Communication unit (L x &)
Pressure probe (L x &)
System length (cable length including
communication unit/pressure probe)
Weight
Communication unit (incl. lithium batteries, DD type)
Pressure probe
Pressure probe cable
Material
Pressure probe housing
Seals
Separating membrane
Cable jacket
Communication unit housing
Conductivity sensor:
Type of protection
Communication unit
Pressure probe

Desiccant

Performance classification of the sensors
according to DIN EN ISO 4373
Measurement reliability

Temperature range

Relative air humidity

EU directives compliance

FCCID
OTT ecolog 800
OTT ecolog 800 3G

50

2"
3"/ 411[ 6"

> 2ll

520 mm x 50 mm
317 mm x 22 mm
2...200m+1 % +5cm

Approx. 0.920 kg
Approx. 0.430 kg
Approx. 0.082 kg/m

POM, stainless steel 1.4539 (904 L)

Viton

Al203 ceramics (96 %)

PUR

Aluminum, PA-GF

ABS, graphite (electrodes) and stainless steel 1.4539 (904L)

IP 68
IP 68

2 capsules (2.65 g silica gel), recommended replacement interval:
Once per year

Performance class 1
Temperature class 2
Class 1

the OTT ecolog 800 (3G) complies with the EU directives applicable
at the time of producﬁon; for details, see Declaration of Conformity
(www.ott.com/resources)

C€

RIZ7T56KT1
RIZHE?10



Appendix A - Note on Declaration of Conformity

If necessary, you can download the current version of the Declaration of
Conformity for the OTT ecolog 800 (3G) from our website as a PDF file:
,Www.ott.com/resources”!
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